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Start Excel on

your computer
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Outline

» Review last lecture on Excel: fixed cell
references, functions and plotting

« Excel tables

* Introduction to VBA
— The macro recorder
— The VBA editor

« More on first programming assignment
— Range names and data validation
— Discussion of and work on remaining tasks
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Review Cell References

» Copying formulas

— A reference like =Al will change as the
formula is copied

— A reference like =$A$1 will not change

—The reference =$A1 will keep column A,
but change rows when copied

— The reference =A$1 will keep row 1, but
change columns when copied

— Formulas like $C2*D$1/2/2 for two-way
tables
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Review Functions

» Built-in worksheet functions listed at

» Use VBA to write your own functions
— Functions calls from worksheet have the
form: =<Function Name>(<Argument List>)
« E.g.: RAND(), SIN(B10), ATAN2(C12, R4), ...
— Square root is SQRT in Excel, SQR in VBA
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Review Plotting Basics

® (TR SO i e ¥
i Eprrlintd™ = .'. . 1.Select data

2.Click Recommended
e ChATES ON Insert tab
: T 3.Select chart from
i resulting dialog
: 4.Click OK
i 5.Use resulting tools
5 to add items such as
= =" legends, axis titles,
and format chart

Scatter with Straig

o o 5
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Line Chart

Data Set

: X y |
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55 3025 Scatter Chart
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Review Plotting Context Menus

A A

* Use “Select Data” to add/remove chart data

» Use “Current Selection” group pulldown
menu to select item to format
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e Use “Add Chart Elemént” to add chart pafté

Data Tables (1/2)

 Data tables allow sorting and filtering by
entries in a given column

« Enter data in columns @™ = =

iz

with column headers =& =,
« Select any cell in table and
click Table Icon in Insert Tab

« Edit cells selected in the
Create Table dialog, if
necessary, and click OK
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Data Tables (2/2)

+ Table in default [ =
format, use pull e T G
down to filter/sort

* Menu for description s e
pull-down shown o i o
here allows sorting =
or having only
certain items show -
in table (filtering)

Rortheidge g

Lecel Options. =
Put check
here and [»
click OK

MenTes | | BewGrovp | | fename.
Cwstemizations: Fgset =

ImpenExpon =

Introduction to VBA

HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW viEw

DEVELOPER

™= *7Record Macra & [ = :./‘ [E] Properties
=/ [ Use Relative References A =iy &1 View C 37 Expansion Pu
tacros Add-dns COM | Insent Design Source
1 Maceo Securdy ddbs | - Mode 0] Rupdialeg

Activate Developer Tab
— Should be located after View Tab

— If not there use following sequence: File
Tab => Options => Customize Ribbon

— Place check in Developer Tab checkbox
See next slide Excel Options dialog
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Macro Recorder (Developer Tab)

« Click Record Macro on B s st
developer tab to record L e P Fefeences

Visusl Macros

keystrokes/mouse clicks “*

t Macra Secusity

Cate

e Enter information in
Record Macro dialog or | "=
leave defaults; click OK |

* Record Macro icon
changes to Stop

Recording “_ =[]
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Macro Recorder (Task Bar) Record a Simple Macro 1/2

Click Record Macro icon ey
to record keystrokes mo[E]
and mouse clicks

Enter information in
Record Macro dialog or §
leave defaults; click OK | ===

1. Open a new worksheet  Record Maero

2. Enter your first name intg | o name
cell AL and copy itinto |, "
cells A2 to A5 ctrl- g

3. Select Cell Al then click | ="
Record Macro icon J—

* Record Macro icon — 4. Fill Record Macro dialog |  cssfortsitotd

changes to 3%top IIII as shown at right and
Recording Pre-2016 click OK

Sheetl

Rowiheidze L Versions » Remiheidze 2

Sub myFirstMacro()

" myFirstMacro Macro Mac ro

" Change font size to 14 T —

* Keyboard Shortcut: Ctrl+q
With Selection.Font

Record a Simple Macro 2/2
5. Change font size to 14 and click Stop

Edit this code to leave

Recording g?gz = Iﬁfia'" only the following:

6. Move to cell A2 and press control+q Strikethrough = False |SUb myFirstMacro()
i i i -Superscript = False Selection.Font.Size = 14
— Did the font size change in cell A2? .Subscript = False
. .OutlineFont = False End Sub
7. Go to the developer tab and click S E .Shadow = False
i i i -Underline = xlUnderlineStyleNone

Visual Basic to go to the VBA editor v v heneColor = xIThaneColor ight

8. You should see VBA code generated -TintAndShade = 0
.ThemeFont = xIThemeFontNone

by the macro recorder as shown on the End With

next slide End Sub
Rortheidge s Rortheidge L

Using Edited Macro

» Click Excel icon to return to worksheet

al M\cmsoMua\ Basic for Applications - Bookl - [Modulel (Code=

€ Edit View Inset Format Debug Run Tools Addlns  Windc

~HIy uoa 5= e UEZHEY

PrOTETt - VBAProject x| [(General

=
atpvbaen.xis (ATPVBAEK Sub myFirstMacro()

8% Solver (SOLVERXLAM) Selection.Font.Size = 14

&4 veAProject (Book1) End Sub|

= icrosoft Excel Objects

| meeneen e On worksheet select

e cells A3:A5 and press
control+q
Calsfornia Sale Unversicy H H
Northridge + Did font size change? | =

ME 209 — Programming for Mechanical Engineers

First Programming Assignment

* Download from course web site
http://www.csun.edu/~Icaretto/me209/pal.pdf

« Computations of ideal-gas density
— R, = Universal gas constant
— Engineering gas constant, R = R /M
— Ideal gas density: p = m/V = P/IRT
—For PinkPa, Vinms3, Tin K, and min kg,
use R, = 8.31447 kJ/kmol-K

— Create table of density versus temperature
for a fixed pressure, P, and molar mass, M
18
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Assignment One — Task One 1/2
A B C D E F

1 |Universal gas constant 8.31447 kJ/kmol-K |deal gas density for Air
2 |Substance Air Temperature Density
3 |Molar Mass 28.966 kg/kmol T(K) u
4 |Pressure 101.325 kPa —B5 300| 117666
5 |Minimum Temperature 300 K =E¥+$B$9400 0.

6 |Maximum Temperature 2500 K 500 0.70599
7 |Temperature steps 22 600 0.58833
8 700 050428
9 |Temperature increment 100 =(B6 — Bp)/B7 800 0.44125

10 |Engineering gas constant | 0.287042|kJ/kg-K 900 0.39222
1 =B1/B3 1000 0.35300

= Density formulaincell F4 (p 1100, 0.52001
13 - o N 1200 029416
14 =P/RT) is =$B$4/(SB$10*E4) 1300 027154
15 - 1400 025214
16 Next slide looks at 1500 0.23533
Californi State niversty
Northridge these two columns 19

ASS|gnment One — Task One 2/2

Tem |p«m| e .
| 1. Click i) 2. Enter first "'"j",ll""
| 1.Clic . 3
1 :;.gug,_; density formula |
and o e o -
rag fill  “Eorsese T
handle rmgn:g .
=ES+5BSS
downto =sjpesass .
getall T :fllwso% 3. Select first cell
values and double click
from fill handle to get
300 to all values
2500
} ?D’Nl
I SESIPED | 2100
0 R — 200 0
2300
= 2400
s sk E2443049 . 200 150
ﬁoll'tlhlll'ltulﬁt' 2 Double click me 2500; " 44T

Review Range Names (Task 2)

» Can assign meaningful names to cells

* Names are used in formulas and show in
name box when cell is selected

» Example below shows change with names
Worksheet Usmg Names Without Names

Density I =Pressure/(Temy BS

A B [} A B
1 i i 1 Ideal Gas Equation for Air
2 Pressure kPa 2 Pressure 100
alr |4 3T 300

4 |Gas Constart [0.287 ik 4 Gas Constart [0.287

5 |Densty re kg |5 |Density =B2NBI'B4)

ﬁo'rt'm-'u"lﬁi Default range names absolute (like $A$1)

Review Getting Range Names

» Select cells with names
adjacent to cells to be named

¢ Choose Create from
Selection in Defined
Names group of Formula
tab

« In resulting dialog box
make sure name location is
correct and click OK

alsfoerii Stale Lnfversty

Northrltlge

Review Name Box

» The name box, to the left of the formula
bar, shows the currently selected cell

« When range names are
defined, this box becomes a
pulldown menu that shows
all the defined names ! - veon’

« Clicking on a name in this menu takes
you to the named cell

» Range names may be used as names
«for.a.range of cells

23
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Review Name Manager

« Main tool for managing range names

— Choose Name Manager in Defined Names
group of Formula tab

— Create, delete or edit names in Manager

« By default names have scope of entire
workbook (named range on one work-
sheet can be used on another worksheet)

« Name manager allows you to make
name scope one worksheet

Califoenia State University 24
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Using Names in Formulas

» When using point and click for a named
range the name will be used instead of
the usual Al notation © — <oenensme -

* For large worksheets oy Ttseinoms-
“Use in Formula” on  Verser & crereromseicton
Formula tab gives list of

Defined Mames

available names il T

&) max

« Starting to type a range s

name gives list of possible S
entries; double click desired name

Northridge
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Assignment One — Task Two 1/3
» Repeat task one using Range names
— Name first tab “Cells”
— Copy sheet and change tab to “Names”
— Delete previous formulas for AT and R and
all table formulas
— Select range A1:B10
— Click on Create from ke
Selection in Formulatab ¢

e w*—'“
— Select location for [ _
names and click OK

[
(e
A |

209065
101 225
001
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Assignment One — Task Two 2/3

» Use Name Manager to verify
that names have actually
been created

» Workbook scope
means that
names can be
used anywhere
in workbook

 Note that names refer to $B$1, etc.; this
.means that names are absolute

Californs Xy
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Assignment One — Task Two 3/3

C

1 |Universal gas constant 8.31447 kJikmol K Ideal gas density for Air
2 |Substance Air Temperature Density
3 |Molar Mass 28.966 kg/kmol T(K) 2
4 |Pressure 101.325 kPa =B5 300| 1.17666
5 |Minimum Temperature 300 K =E4+$B$9400 ~T.

6 |Maximum Temperature 2500 K 500 0.70599
7 |Temperature steps 22 600 0.58833
8 700 0.50428
9 |Temperature increment 100 =(B6 — B5)/B7 800 0.44125

Engineering gas constant | 0.287042|kJ/kg-K 900 039222
=B1/8B2 1000  0.35300

d =4l

1 Density formula in cell F4 (p = P/RT) is =$8%4/($B$10*E4) 0 23281
14 Reenter previous formulas using 300 027154
15 q a 400 025214
16 point and click to get range names :y; 5333
Californda Stale intersiry 28
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Names to Existing Formulas

— Adding names after entering @ P——
formulas does not use names in i Name...
existing formulas / hager  ApplyNames..

- Cllc_k the down arrow next to —— -
Define Names and select e
Apply Names from the

. hetaDegrees
resulting submenu el

— Select names in Apply names
dialog and click OK

. o rore Relatve Absclite.
« Can leave settings for CNeCKDOXES || e om s shmmnsmes Gotera v
LAt b\‘ottom of dialog as set by Excel = | [ome

Northrltlge
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Data Validation 1/2

 Allows spreadsheet designer to set
limits on data by other users (or self)

« Validation icon =

located in Data Tools = -

group of Data Tab

» Use Allow: box to set P T
type of data and o
other boxes to set
limits
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Data Validation 2/2
Selecting Whole Number,

Decimal, Date, Time, or Text S_elec_tlng
length gives choices below, List gives
with user-specified values box t_o Input
—_— ~location of
P N |

Validation riteria between Z

not between

equal to

not £qual to

greater than

less than

greater than or equal to
fess than or equal to

|
|
|
|

‘California Stale niversty
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Data Validation for Lists

 Results in pulldown menu for valid

ch0|cesAseIecteBd by quer Click pulldown

1 |Gas Constant 831447 kJ/kmol-K rrow to get
2 |Substance

menu of allowed

3 |Molar Mass ps + Vkmol

4 |Pressure ;;‘;T,Z a names

5 [Tmin Propylene

Sulfur D d

6 |Tmax luene Enter table-look-

7 |Steps ]

8 up formula to get

9_|deltaT 100 molar mass from

10 |EngrGasConst  0.173229 kJ/kmolxK

& name table
et e €€ NEXt slide for result of selecting Water
Calornia St e i
Northridge

Assignment One — Task Four

 Construct two-way table

A

Deraizy tible for Hydrogen (kyim')

Final two- :-:
way Table

Input Data Table
with Names

Detailed Instructions
in Assignment

Final Table in Equation View

Californin State University 35
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Assignment One — Task Three

. . . Mol
+ Data validation gives user an [rame Mass
A { 26.0373|
automated molar mass entry = 38.965
based on substance choice  [immona__ 1705
Bt 78.1118
— Download the workbook from  |saiadiens | 54.0904
the molar mass table link on ~ 2une 28222
N 44.0095
the course home page Dioxide
» Copy table to your worksheet Monoxide 28,0104
) ) ) [Chlorine 70.906)
— Follow directions on assign- Ethane 30.069
[Ethyl Chloride | 64.5141]
ment to get substance menu Ethylene 28.0532)
that gives molar mass Fluorine __37.996808
s AUtOMatically Hexane 86.1754
Cabborra Sale | Tinerty rogen
Northridge o 36.4609

Data Validation Choice: Water
A B © D

1 lGas Constant 831447 kJkmolK Table look-up

2 |Substance Water 7

3 Molar Mass 18.075 Jg/kmol formula for

4 Pressure 101.325 kPa B
e m«\molar mass in
6 Tmax 2600 K cell B3

7 Steps 22

8

9 deltaT 100

10 EngrGasConst 046153 klkmolxK Text formula for
i substance

I e name in table
15 header in cell
16 400 054885

.4.7, Enn nA20nQ 813
Cai -ll"\l.\l:lll-|‘:lll1r\'l 24
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Assignment One — Task Five

» Create density-temperature plot from
two-way data table in Task Four
— Plot three pressures only for simplicity

e SelectT . Density Table for Hydrogen [ke/m')
column and
columns for
pressures
then insert e ——
scatter chart
and format -
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